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  Word of the Month – HACKING 
Hacking is the activity of identifying weaknesses in a computer 
system or a network to exploit the security to gain access to personal 
data or business data. An example of computer hacking can be: 
using a password cracking algorithm to gain access to a computer 
system. 
Ethical Hacker (White hat): A security hacker who gains access to 
systems with a view to fix the identified weaknesses. They may also 
perform penetration Testing and vulnerability assessments. 
Cracker (Black hat): A hacker who gains unauthorized access to 
computer systems for personal gain. The intent is usually to steal 
corporate data, violate privacy rights, transfer funds from bank 
accounts etc. 
Grey hat: A hacker who is in between ethical and black hat hackers. 
He/she breaks into computer systems without authority with a view to 
identify weaknesses and reveal them to the system owner. 
Script kiddies: A non-skilled person who gains access to computer 
systems using already made tools. 
Hacktivist: A hacker who uses hacking to send social, religious, and 
political, etc. messages. This is usually done by hijacking websites 
and leaving the message on the hijacked website. 
Phreaker: A hacker who identifies and exploits weaknesses in 
telephones instead of computers. 

Cybercrime is the activity of using computers and networks to 
perform illegal activities like spreading computer viruses, online 
bullying, performing unauthorized electronic fund transfers, etc. Most 
cybercrime hacks are committed through the internet, and some 
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cybercrimes are performed using Mobile phones via SMS and online 
chatting applications. 

Do you have a false sense of security 
online? Take this quiz to find out Norton/Nicholson 

 

Question 1: Do you know what a VPN is? And do you use 
one? (Club Bytes Vol. 5 page 6) 
If you answered “no” to this question, you’re potentially exposing 
your activity every time you go online.  A VPN is short for virtual 
private network, a service that encrypts the data you send and 
receive when you are online and hides your activities in a type of 
virtual tunnel. VPNs also have the added benefit of hiding your IP 
address from snooping eyes. 

Question 2: Do you ever access your online bank or credit 
card accounts while using public Wi-FI? Better not be. 
You should answer “no” to this question. That’s because public Wi-FI 
is notoriously easy for hackers to crack. If you use the free public Wi-Fi 
offered by hotels, coffee shops, and libraries, only use it for benign 
activities, such as reading the news, checking the weather, 
and searching for local restaurants.  Never use it to access your 
important financial portals or other sensitive data. You never know 
when a hacker is snooping on you. If you use public Wi-Fi to log into 
your bank account, a hacker could capture your username and 
password. That same hacker can then quickly access your 
bank account and drain funds from it. 

Question 3: Have you enabled two-factor authentication for 
your most sensitive online accounts?  PLEASE do this. 
The answer here should be "yes." Two-factor authentication, also 
known as 2FA, adds an extra step, and an extra layer of protection, 
when you log onto a website, online bank account, or online credit 
card portal.  Here's how 2FA works: When you log into your online 
bank account, you'll first enter your username and password as 
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usual. But after you enter this information, the site sends a text 
message to your phone. This message contains a six-digit code. You 
must then enter this code before you can finish logging into your 
bank account. 

Question 4: Do you ignore software updates?  Gus Best will 
visit you if you get this one wrong. 
You should answer “no” to this question, at least if you want to 
protect your devices and your privacy. 

Question 5: Have you installed security software on your 
computers?  The entire staff of the Repair shop will be at 
your door. 
Good security software can help keep malware and viruses away 
from your laptop and desktop computers. So, do you have this 
security software installed and scheduled to run on your devices? 
(And, yep, you should answer “yes” to this question.) 

Question 6: Can you recognize a phishing email? 

We admit it: This isn’t a fair question. Scammers have gotten good at 
sending phishing messages — emails or texts designed to trick you 
into surrendering such key information as your Social Security 
number, birthdate, address, bank account number, or credit card 
log-in information. Even if you remain on the lookout for phishing 
attempts, there’s no guarantee that you won’t fall for them.  If you 
said “never,” that’s the wrong answer. You can access each of your 
three credit reports — one each maintained by the national credit 
bureaus of Experian, Equifax, and TransUnion — once a year for free 
by logging onto AnnualCreditReport.com. 
  
Why do we ask these questions?  The Repair shop has 
fielded way too many hacked computers in the last couple 
of months.  Some of our members have lost money, had 
their bank accounts compromised and credit cards used 
illegally.  Besides the financial implications, their computers 
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had to be “wiped”, operating systems reinstalled, passwords 
redone for all their applications, NC Attorney General and 
police notified, Microsoft or Apple made aware of fraud. 
 
Think you’re staying safe when you’re online downloading files, 
viewing YouTube videos, and surfing the news? Think again.  If you’re 
like many respondents in a survey from the National Cybersecurity 
Alliance, you’re probably more at risk for downloading malware or 
being tricked into surrendering your bank account or credit card 
information than you think. 

What does the survey say? 
According to the alliance's Cybersecurity Awareness Month report 
released in September 2020, only 35 percent of respondents say they 
update their antivirus, firewall, or anti-malware software on a regular 
basis. And only 39 percent said they enabled two-factor 
authentication on all devices connected to their network.  The same 
survey found that only 20 percent of older respondents — those 55 
and older — are very confident that they would be able to identify a 
malicious email or link. Only about half of 18- to 34-year-olds said 
they felt confident that they could identify suspicious emails or links.  
And when it comes to public Wi-Fi? The survey found that 54 percent 
of 18- to 34-year-olds report using public Wi-Fi, while 42 percent of 55- 
to 75-year-olds never use it. That’s concerning public Wi-Fi is 
notoriously vulnerable to cyberattacks.  What do these results show? 
A large number of people aren't taking the appropriate steps to 
protect themselves when they're online. They're giving hackers, con 
artists, and scammers plenty of opportunities to expose their 
computers and mobile devices with malware, steal their identities, 
access their bank accounts, or run up fraudulent purchases on their 
credit cards. 

We can not stress enough to be careful.  Medicare, Social Security, 
Microsoft, Apple, Amazon, IRS, U.S. Government, and numerous 
other large companies do not call you.  They send letters.  Even then 
check the phone number and be cautious. 



Can Hotel Internet Traffic Be Sniffed? 

by Leo A. Notenboom 

Many hotels offer both wired and wireless internet, but with those 
hotel internet connections comes a security risk most folks don't 
consider. 

Hotel internet security is one of the most overlooked risks travelers 
face. I’m not just talking wireless — I’m talking about any internet 
connection provided by your hotel. 

Any internet connection provided by a hotel or other business or 
public place is as untrustworthy as an open Wi-Fi hotspot, and you 
should treat it as such. That means making sure all connections are 
encrypted, using a VPN, or using some alternate internet 
connection, such as your mobile data plan. 

To read the full AskLeo article, Ctrl Click or copy and paste this link 
into your browser:  
https://askleo.com/can_hotel_internet_traffic_be_sniffed/ 

To view the AskLeo video, Ctrl Click or copy and paste this link into 
your browser:  
https://askleo.com/can_hotel_internet_traffic_be_sniffed/ 

10 useful Mac tips 
Here's another short collection of tips.  I bet some of you 
may not even know about them. 

How to combine files into a PDF with Preview 
So, you’ve got two or more different PDF documents and you want 
to combine them all into one, perhaps for a report? There are two 
ways to achieve this: 
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• Find and select the documents you want to combine 
and Control-click them to access the available controls. At the 
bottom, select Quick Actions and then choose "Create PDF." 

• Or open one of the files in Preview and use the top left drop-
down menu to select Thumbnails. You should then see previews 
of each page of the document appear in the sidebar. Once 
the thumbnails of the first PDF are visible, you can add more 
PDFs using drag and drop into the sidebar — like adding a 
page. Even multi-page PDFs can be added with this one 
gesture. It’s dead useful. 

How to merge calendars 
• As can happen with other data on our Macs, we may 

eventually end up with multiple calendars for different 
purposes. That gives rise to the need to merge some of these to 
help keep and organize the data inside them. Here is how to 
merge different calendars. 
[ Further reading: 40 tips to get the most from your Mac (and 
macOS 'High Sierra') ] 

• Open Calendar and click on Calendars at the top of the 
screen to find all your current groups. Now select a calendar 
you want to merge and control-click its entry in the list; that will 
summon up a menu from which you should choose Merge. 
You’ll be given the opportunity to merge this calendar with 
another from the list. Events from both calendars will be 
combined. 
One more tip: To see all your upcoming entries from all your 
calendars, just type a period (.) in the Calendar search box. 

How to speed up iCloud 
Saved something on one of your Apple devices, but it hasn’t 
showed up yet on your Mac? Or are you looking for a Photo 
that doesn’t yet seem to have proliferated across iCloud? 
There are a few things you can do but one that seems to work 
best is to ensure both devices are connected to power — and 
restart the Mac. 

https://www.computerworld.com/article/3227916/mac-os-x/40-tips-to-get-the-most-from-your-mac-and-macos-high-sierra.html
https://www.computerworld.com/article/3227916/mac-os-x/40-tips-to-get-the-most-from-your-mac-and-macos-high-sierra.html


Send a Safari page… fast! 
Here's a super-useful Safari tip: If you are working on or researching a 
topic in collaboration with someone else, or simply want to quickly 
share a web page, tap Command-I to open a new email containing 
the content of the page you are on. Or you can use Command-
Shift-I to create a new email containing only the URL of the page. 

A fast way to access System Preferences. 
This is a quick way to access specific System Preferences: Press and 
hold the System Preferences icon in your Dock. Wait just a second 
and a contextual menu listing all those preferences will appear, just 
select, and click on the one you need to access.  

Make use of Smart Folders. 
Automate project management with Smart Folders. These can 
automatically gather tasks with certain keywords, dates, and many 
other parameters. Take a look. 

Use Text snippets 
I’ve been a fan of these ever since I came across them. If you have 
text you regularly need to write, why not make life automatically 
place in any document by dragging-&-dropping the snippet into 
any document. 

Here is how to create one: 

• Write the text (addresses, legal warnings, whatever it might be, 
and it can include links). 

• Select the text and drag it to your desktop. 
• You’ll now find a Text Snippet on your Desktop. 
• Give it a memorable name and save it in a new folder 

somewhere. 

https://www.computerworld.com/article/2476275/os-x--everything-you-need-to-use-smart-folders.html


• Call that folder Snippets and drag the folder into the left-hand 
column of a Finder window, after which it should always be 
visible there. 

• You can add as many Snippets to that folder as you want. 

In the future, you can just drag the relevant snippet from the easy-to-
access folder in the Finder window sidebar directly into the 
document to save a little time. 

Many people like to use Text Replacement for tasks like these. But I 
like the ease-of-use of Snippets, plus I don’t need to remember 
keyboard combinations. 

If your Mac performance seems slower than normal, it might be that 
an open browser window, email app or some application processes 
may be using all your available memory. The solution is simple: quit 
your browser first. If you see an improvement, then it was probably a 
website eating up the memory. If you don’t, restart your Mac. 

If no discernible improvement is then seen, then you may need other 
forms of support.  That would be our friendly Apple Support in the 
Repair Shop on Mondays. Please call for an appointment. 

If you forget your Apple ID password, you can reset it at the Apple ID 
website; just tap Forgotten your Apple ID or password and follow the 
process there. You will need to use the email address associated 
with your account and answer some security questions. 

a little easier to use send re-use by creating a Text Snippet? These 
are snippets of text you can automatically place in any document 
by dragging-&-dropping the snippet into any document. 

Here is how to create one: 

• Write the text (addresses, legal warnings, whatever it might be, 
and it can include links). 

• Select the text and drag it to your desktop. 
• You’ll now find a Text Snippet on your Desktop. 

https://www.applemust.com/how-to-%C2%AF_%E3%83%84_-%C2%AF-without-tears-on-ios-mac-and-android/
https://www.computerworld.com/article/2995962/6-disk-utility-changes-in-el-capitan.html
https://www.computerworld.com/article/2995962/6-disk-utility-changes-in-el-capitan.html
https://appleid.apple.com/
https://appleid.apple.com/


• Give it a memorable name and save it in a new folder 
somewhere. 

• Call that folder Snippets and drag the folder into the left-hand 
column of a Finder window, after which it should always be 
visible there. 

• You can add as many Snippets to that folder as you want. 

In the future, you can just drag the relevant snippet from the easy-to-
access folder in the Finder window sidebar directly into the 
document to save a little time. 

Many people like to use Text Replacement for tasks like these. But I 
like the ease-of-use of Snippets, plus I don’t need to remember 
keyboard combinations. 

If your Mac seems slow and sluggish... 
If your Mac performance seems slower than normal, it might be that 
an open browser window, email app or some application processes 
may be using all your available memory. The solution is simple: quit 
your browser first. If you see an improvement, then it was probably a 
website eating up the memory. If you don’t, restart your Mac. 

If no discernible improvement is then seen, then you may need other 
forms of support.  That would be our friendly Apple Support in the 
Repair Shop on Mondays. Please call for an appointment. 

 

What to do if you forgot your Apple ID 
If you forget your Apple ID password, you can reset it at the Apple ID 
website; just tap Forgotten your Apple ID or password and follow the 
process there. You will need to use the email address associated 
with your account and answer some security questions. 

How to type a degree symbol 
There are two keyboard shortcuts that let you type a degree symbol: 

https://www.applemust.com/how-to-%C2%AF_%E3%83%84_-%C2%AF-without-tears-on-ios-mac-and-android/
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• Option-Shift-8 gives you 99° (the temperature symbol). 
• Option-K provides 99˚ (the degree symbol). 

I can’t really tell the difference between the two, but now you know. 

There is also Option-0, which is used in some languages. º 

 

 
How to Uninstall or Disable Extensions in Google Chrome 

BENJ EDWARDS  @BENJEDWARDS 
JANUARY 8, 2021, 9:00AM EDT 

Extensions can add a wide range of new features and functionality 
to Google Chrome, but sometimes you need to remove or disable 
one or more of them. Here’s how to do it. 

First, open Google Chrome. In any window, look for the “Extensions” 
icon in the toolbar, which looks like a jigsaw puzzle piece. Click it. 
(Alternately, you can open the main menu by clicking the three dots 
button and select More tools > Extensions.) 

 

When a menu pops up, select “Manage Extensions.” 

https://www.howtogeek.com/701073/how-to-uninstall-or-disable-extensions-in-google-chrome/
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In the “Extensions” tab that appears, locate the name of the 
extension you’d like to uninstall or disable. Each extension has its own 
box on the Extensions tab. 

If you’d like to disable the extension but not uninstall it, click the 
switch beside it to turn it off. At any time, you can return to the 
Extensions tab and re-enable it by flipping that switch again. 

 

If you’d like to uninstall the extension permanently, click the 
“Remove” button. This will completely remove the extension from 
Chrome, and you won’t be able to use it anymore (unless you 
reinstall it later). 



 

When a confirmation window pops up, click “Remove” again. 

 

The extension will be removed completely. 

Alternately, to quickly remove an extension, you can also click the 
“Extensions” button in the toolbar, click the vertical ellipses button 
beside the extension’s name, then select “Remove from Chrome” 
from the menu. 

 



If you ever need to reinstall the extension you just removed, you’ll 
have to visit the Google Chrome Web Store and download it again. 
Happy browsing! 

RELATED: How to Install and Manage Extensions in Chrome 

 
 

 

How to Safely Remove USB Flash Drives 

You’ve probably heard about how you should always safely “eject” 
a USB drive before unplugging it. On Windows, it’s a very simple 
process, but what about on a Chromebook? Should you still do it? 
How does it work? 

Why You Should “Eject” Before Unplugging 

Before we talk about how to safely remove a USB drive from a 
Chromebook, you might want to know why it’s important.  The main 
thing you risk when yanking out a USB drive is data loss. If data is 
being written to the drive, you could interrupt that process by 
removing it. Telling the operating system to “eject” the drive before 
you physically remove it ensures that all the processes are ended.  If 
you know that the drive isn’t active, there’s no harm in pulling it out 
straight away. Sometimes this is indicated by an LED on the drive 
itself. The light will flash when data is being read or written.  The moral 
of the story is that you never want to remove a USB drive when it’s in 
the middle of a process. The “eject” option simply ensures that you 
don’t have any data loss and that all data processes have been 
stopped safely. 

How to Eject a USB Drive From a Chromebook 

Ejecting a USB drive on a Chromebook is different from other 
platforms. You need to open the “Files” app to do it. Click the App 

https://chrome.google.com/webstore/category/extensions
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Launcher icon in the bottom-left corner to see all of the apps 
installed on your Chromebook. From there, open the “Files” app. 

 

You’ll see your USB drive in the left sidebar. All you have to do is click 
the eject icon. 

 

Alternatively, you can right-click the drive and select “Eject Device.” 

 

If your USB drive has a built-in LED status light, it will blink a few times 
and then stop. It’s now safe to remove the drive. If it doesn’t have a 
light, just wait a few seconds before pulling it out. That’s all there is to 
it! 

     Did You Know? The GPS Triangle Cursor Comes From 
Atari’s Asteroids  BENJ EDWARDS  @BENJEDWARDS 

TierneyMJ / Shutterstock 
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It’s there right in front of you every time you use GPS navigation: a 
triangle-shaped cursor representing your location on a GPS display, 
moving where you move. But did you know the cursor originates 
from Atari’s 1979 Asteroids arcade game? Here’s how it came to be.  
Do a Control + Click and read the fun stuff in the article. 

https://www.howtogeek.com/696738/did-you-know-the-gps-triangle-cursor-comes-from-
ataris-asteroids/ 

 

How to Crop a Picture in Microsoft Word 
Do you like to play with picture shapes, crop, aspect ratios? 

You can remove unnecessary pixels from an image directly 
in Microsoft Word using the built-in cropping tool. You can also crop 
a photo to fit a specific shape. Here’s how to crop a picture in 
Microsoft Word. 

How to Crop a Picture in Word 

To crop a picture in Microsoft Word, open the Word document, add 
an image (Insert > Pictures), and then select the photo by clicking it. 
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Next, go to the “Picture Format” tab, which appears after you select 
the image. Then, in the “Size” group, click “Crop.” 

 

In the drop-down menu that appears, select “Crop.” 

 

Cropping handles will now appear around the frame of the image. 
To crop out certain areas, click and drag the handles to capture 
only the content that you want to keep. 

 



After setting the cropping frame, click the icon in the upper half of 
the “Crop” option in the “Size” group of the “Picture Format” tab. 

 

The unwanted areas of your image are now removed. 

 

 

How to Crop a Picture as a Shape in Word 

To crop an image as a shape, open the Microsoft Word 
application, insert an image (Insert > Pictures), and then select the 
image by clicking it. 

https://www.howtogeek.com/439038/how-to-insert-a-picture-or-other-object-in-microsoft-office/


 

In the “Picture Format” tab, which appears after selecting the 
image, click the “Crop” button found in the “Size” group. In the 
drop-down menu that appears, select “Crop To Shape.” 

 

A sub-menu displaying a large library of shapes will appear. Select 
the shape that you’d like to crop the image as by clicking it. We’ll 
use the teardrop shape in this example. 

 

Your image will now be cropped as the selected shape 
automatically. 



 

You can also do things such as removing the background from an 
image, annotating an image, and more. 

 
How to Add Private Labels in Google Maps 
 
Google Maps offers various recommendations for travelers, including 
important landmarks to nearby businesses. If you want to save your 
own recommendations to Google Maps to quickly find in the future, 
you can do so by adding private labels. Here’s how. Read More » 
 

How to Enable Do Not Disturb During Workouts on Apple 
Watch 
If you’re in the middle of a hard run or chill yoga session, you 
probably don’t want your phone to ring (unless it’s really important). 
By automatically enabling Do Not Disturb on your Apple Watch 
when you start a workout, you can make sure you don’t get 
interrupted. Here’s how.  https://www.howtogeek.com/711255/how-
to-enable-do-not-disturb-during-workouts-on-apple-watch/ 
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How to Stop Annoying Website Notification Pop-Ups in Edge 

Microsoft Edge is a great web browser when it comes to speed 
and features. But website notification pop-ups can spoil your 
browsing experience and clutter your notifications. Microsoft Edge 
for Desktop (Windows 10 and Mac) and Android both have a built-in 
notification system for websites (It’s not available on iPhone and 
iPad.). Here’s how to stop annoying website notification pop-ups 
in Microsoft Edge. 

https://www.howtogeek.com/714111/how-to-stop-annoying-
website-notification-pop-ups-in-edge/ 
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